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Introduction to Invoices

The Invoices program allows you to generate invoices for client remittance, issue statements of
receivables, and create checks for your clients. Invoicing is based on account collection activity in
Latitude.

Ensure that your organization set the following Accounting permissions for each user of Invoices:
1. Access Invoices Program: Allows users to open Invoices.

2. Enter AR Payments: Allows users to add accounts receivable payment information to apply
toward invoices.

Enter Bank Transactions: Allows users to add bank transactions for trust accounts.

3

4. Generate Invoices: Allows users to generate invoices.

5. Generate Statements: Allows users to generate statements.
6

Print Checks: Allows users to print and reprint checks.

Related Topics

What's New in Invoices

Log On to Invoices

Overview of Invoices Window

Help Overview
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What's New in Invoices

The following Service Updates (SU) introduced changes and enhancements to Invoices 13.0:

SU

Related Topics

Introduction to Invoices

Log On to Invoices

Overview of Invoices Window

Help Overview
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Log On to Invoices

Use the Interaction Collector Logon dialog box to log on to Invoices.
To log on to Invoices

e Click Start > All Programs > Interactive Intelligence > Interaction Collector > Invoices or double-
click the Invoices icon. The Interaction Collector Logon dialog box appears.

ar n ..: L

Uszr Mams: ||

Passyrard: |

Database: |Dafa_.|lt Instance ﬂ

[~ Login using Windows authentication
_ concel |

1. Inthe User Name box, type your Latitude user name.

2. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

3. Click Okay. The Invoices window appears.

Note: If your agency has over 1,000 customers, a dialog box appears, prompting you to bypass
loading of all customers. To prevent slow response times when opening the Invoices window,
click No. A second dialog box appears, indicating the operation may take several moments to
return results. Click No again.
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Log On to Invoices

Summany of Invaices | Summesy of Open Items |

i D0000DD-DEFALILT

g3 0000001-CUSTOM All Customers

[} 0000002-CUSTOM

- 3 0000003-POD CUS

- 0000004-CUSTOM Views Date Range
mmswméTEgJ [ I6/3/amz =] w [4n0em3 -]
0000007-FIRST CL
D0000DE-SECOMD
0000003-THIRD CL
o00010-DISHEY € Conzobdated Summary of Irwoices for All Customers:
0000011-4EC Custh Irvvoice Giross Collections Fees

lwoics | Date | Spsbn|  PadUs | PaidCust | Total Pt | Eamed

85 &M | 410/2M3

Related Topics

Introduction to Invoices

What's New in Invoices

Overview of Invoices Window

Help Overview
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Overview of Invoices Window

Use the Invoices window to generate invoices, issue receivables statements, and create checks for your
clients.

= Invoices e x
Actions Tools View Reports 1
5 il Custorners Summarny of roices ] Summary of Open ltems | 3
i C000000-DEFALILT
- GE 0000001-CUSTOM All Customers
| D000002-CUSTOM
| 0000003-POD CUS
(8% 0000004-CUSTOM ~View Date Range
1 al DOODDDS-DIALER T
CO0000E-CLIS TOM I6/3/am2 =] w[4n02m3 =]
OO00007-FIRST CL
D00000E-5E COND
0000005-THIRD €1
o000 O-DISMEY € Consobdated Summary of Irvoices for All Customers
000001 1-ABC Cush Irrvnice Gress Collections Fees Summary
lwoice | Date | SpsMo| PadUs | PadCust | TotalPmtz | Eamed Duels |  DueCust

P p—— '

Customet Group | Selected: "Nl Customers” CBSIAM | 4n0E013

2. Menu: Displays the commands that are available for the window.

3. Navigation pane: Displays the available customers. The icons indicate if the customer is the
parent customer, child customer, or a standard customer.

Icon | Description

Parent customer. You can use parent customers to combine invoices for multiple
ey} customers under one invoice. For example, your agency may hold accounts for a major
company (parent customer) that has several subsidiaries (child customers).

o Child customer. You can assign child customers to a parent customer for invoicing
purposes. You cannot invoice a child customer separately.
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Overview of Invoices Window

ﬂ Standard customer. Customers that your organization hasn't associated to other
customers.

4. Tabs: When you click a customer in the Navigation pane, the associated information appears on
the selected tab.

Related Topics

Introduction to Invoices

What's New in Invoices

Log On to Invoices

Help Overview
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Help Overview

Invoices help provides you with information for using Invoices. Use the table of contents, index, and
search features to locate and view a topic.

To open help

In the "\Interactive Intelligence\Interaction Collector\Documents" folder, double-click Invoices.chm.

B Help System - O Y

g = = &

bide  Back Fowsd Pmt |

Q;rlu'h]w lwl 2 3 Home | Help Syitem /M
LY Helr System =1 - . i
[7) What's New 3 GENESYS 4 feedhack
Lagan
Book 1 Introduction 5
Book 2
Book 3 This graphic represents the help system layout

for Latitude by Genesys products.

Lorem ipsum dolor sit amet, vix id quot
aperiam sententiae, no mea definiebas
referrentur voluptatibus. Soluta meliore eu
miei, pro alienum legendos definitionem in,
sumo essent legendos ea vix. At vim veritus
senserit adversarium, has in dignissim
conceptam, ei sit veritus accumsan. Te odio
urbanitas pri, tamguam honestatis vel ex, at
guo enim virtute.

Mei impetus saperet ea, no saperet
disputationi his. Nam diam quas appellantur
cu. Duo nonumy vituperata in. Nec ax saperet
civibus denigue, quo dolorem consetetur eu.

Tip: To adjust the width and height of the window or its panes, click the edge of the window or pane
and drag it up or down, left or right.

5. Toolbar: Displays options for the help window.
6. Tabs: Displays the following:

Contents: Displays the table of contents. To display a topic in the Content pane, expand a book
and then click the link.

Index: Displays the index. To display a topic in the Content pane, type a keyword or phrase in the
box (or scroll through the list) and then click the link in the list.

Search: Displays the search feature. To display a topic in the Content pane, type a keyword or
phrase in the box and then press Enter. In the search results, click the link.
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Glossary: Displays a list of terms and their definitions. To display a definition, click the term.

7. Breadcrumbs: Displays your current location within the help system. When you click a
breadcrumb, the related topic displays.

8. Content toolbar: Displays an option to send feedback through an email message to Latitude by
Genesys Documentation.

9. Content pane: Displays the contents of a topic. To view the Content pane menu, right-click in
the Content pane.

Search feature

You can use the search feature to search for topics that contain words or phrases that you specify. You
formulate a search query following a specific set of rules. You can include wildcard expressions, Boolean
operators, and nested expressions in your search query. A list of topics that match your search criteria
appear in the search results. When you click a topic title in the search results, the content of that topic
appears in the Content pane.

Search syntax
The basic rules for formulating search queries are:
9. Searches are not case-sensitive, meaning you can type uppercase or lowercase characters.

10. You cannot search for a single character or the following reserved words: an, and, as, at, be, but,
by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which,
with, you.

11. The search engine ignores punctuation marks and special characters such as @#5%*&()=+[]\.

12. Enclose phrases and terms that include a period (such as a file name with an extension) in
double quotation marks.

Wildcard expressions

Wildcard expressions allow you to search for one or more characters using a question mark or asterisk.
A question mark represents a single character, while an asterisk represents one or more characters.

Search for... Example [Result

Topics with text that starts with one or
more specified characters and ends in |og or log*
any character or number of characters

Returns all topics with text that starts with the
specified characters (for example, log, logon, logging.)

Topics with text that starts with the
specified characters, has a single
character that can be anything, and
ends in the specified characters

Returns all topics with text that has any character
32?57 where you placed a question mark (for example,
327?57 returns 32257, 32457, and 32857.)

Returns all topics with both account and status, but
account |not necessarily as a phrase or in the order specified.
status For example, the search returns topics with "the
account status..." or "the status of the account..."

Topics that contain all the words
specified, in any order or placement
within the topic
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Returns all topics with account status as a phrase. For
xample, the search returns topics with "the account
tatus..." but not "the status of the account..."

opics that contain the specified "account
phrase tatus"

Boolean operators

Boolean operators (AND, OR, NOT, NEAR) allow you to create a relationship between terms. If you don't
specify an operator, the system uses AND by default.

Search
Example Result
for...
Returns all topics with both account and status, but not necessarily as a phrase or
account AND|. o . S
AND ctatus in the order specified. For example, the search returns topics with "the account
status..." or "the status of the account..."
account OR . . .
OR ctatus Returns all topics with either account or status, or both.
account NOT . .
NOT Returns all topics with account but not status.
status
account . S
NEAR Returns all topics where account is within eight words of status.
NEAR status

Nested expressions

Nested expressions allow you to perform complex searches. For example, queue AND ((collector OR
clerical) not supervisor) finds topics containing queue and collector but not supervisor, or containing
queue and clerical but not supervisor. As with mathematical expressions, the system evaluates
expressions in parentheses first. If there is no parenthesis, the system evaluates the expression from left
to right. For example, queue NOT (clerical OR supervisor) finds topics containing queue but not clerical
or supervisor. Queue NOT clerical OR supervisor finds topics containing queue but not clerical, or topics
containing supervisor.

Related Topics

Introduction to Invoices

What's New in Invoices

Log On to Invoices

Overview of Invoices Window
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Customers

Use the Invoices window to select groups of customers to view, search for customers, and modify
customer information. You can also set up customer groups and associate customers to the groups.

Related Topics

Select Customers to Display in the Navigation Pane

Search for a Customer

Modify Customer Information

Customer Groups

Feedback

S GENESYS

Select Customers to Display in the Navigation Pane

Use the Invoices window to select the customers to display in the Navigation pane.
To select customers to display in the Navigation pane
10. In the Invoices window, from the View menu, do one of the following:

1. Todisplay a list of all customers, click All Customers. The Navigation pane displays a list
of all customers.

2. Todisplay a list of customers that your organization invoices monthly, click Monthly
Customers. The Navigation pane displays a list of customers that you invoice monthly.

3. Todisplay a list of customers that your organization invoices weekly, click Weekly
Customers. The Navigation pane displays a list of customers that you invoice weekly.

4. To display a list of customers that your organization invoices on demand, click On
Demand Customers. The Navigation pane displays a list of customers that you invoice
on demand.

5. Todisplay a list of customers in the default customer group, click Default Group. The
Navigation pane displays a list of customers in the default customer group.

6. Todisplay a list of customers in a specific customer group, click the group name. The
Navigation pane displays a list of customers in the specified customer group.

10
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Related Topics
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Search for a Customer

Use the Simple Search tab in the Search - Search for Customer window to search for a customer.
To search for a customer

12. From the Tools menu, click Find Customer. The Search - Search for Customer window appears.

—
Teememe T

Simple Search I Search Results ] For help with wild card searching, dick here,

Customer Code: 0000001

Customer Hame:l
Customer Gmuni Mo items selected. &l
Alpha Code: |
Contact Name: |

Maximum results: 250 == Search complete, 1 results retumed. Clear | | Search I

13. On the Simple Search tab, type search criteria into one or more boxes.
I Tip: For fewer results, provide more information. For more results, provide less information. I

1. Click Search. The results display on the Search Results tab.

Simple Search  Search Results |
Customer Code | Customer Mame | Alpha Code | Company Name | Contact Mame | Address
0000001 CUSTOMER ONE 123 MAIM STREET | JACKSOMYILLE

| | 3

Maximum results: | 750 5: Search complete, 1 results retumed. Back | | Selact I

2. Click Select. The customer's information displays in the Invoices window.
Related Topics

Customers

11
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Modify Customer Information

Use the Customer Properties window to modify customer information. For more information about this
window and its tabs, see the "Maintain a Customer" topic in the Latitude documentation.

To modify customer information

3. Inthe Invoices window, in the Navigation pane, right-click a customer and then click Properties.
The Customer Properties window appears.

(M Cosomerproceries o000t cusToweRone ]

General | account | Fees | mvoice | Services | Wfo | Desk Distriution | Comments | custom |

Code 0000001 Stahss |ACTIVE |
AlphaCode | |
Mane |CUSTOMER OME |
Addiass [123MAIN STREET |
[SLITE 100 |

Ciw/Staie/Zip  [/ACKSONVILLE [[FL | |z2248 |
Cantact [MaTT |
Phone [F51212 = |
|

Email Address |I:-a'|:-a'a martindirin. com

Prinity o

4. Modify the information as necessary and then click OK.
Related Topics

Customers

Customer Groups

Feedback
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Customer Groups

12
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Use the Customer Groups window to add and modify customer groups. Customer Groups represent
general types of collection business given to your agency. You can use Customer Groups to categorize
customers for invoicing and statistics. You can place individual customers into one or more groups (or
none).

Related Topics

Add a Customer Group

Modify a Customer Group

Delete a Customer Group

Modify Customer Group Settings

Add a Customer to a Customer Group

Modify a Customer in a Customer Group

Delete a Customer from a Customer Group

Feedback
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Add a Customer Group

Use the New Custom Group dialog box to add a customer group.
To add a customer group

5. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

13
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1.
2.

Q Meww Groug e Refresh

Customers

! Customer Groups EE x

-
= Banks - Bankz

-2 Schools - Schodls

L) 000000 - Smslkown Bank
[4-[Z] Credit Card Custoeness - Credit Cz

|

Custom Group's Descriptian (100 Char- Optional)

H Search

Code | Mame | Clazz
El 0000003 BOBES HARLEYS 00001 - RETAIL
EI 0000000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSIMNESS
£l 0000005 Famners Bank. 00001 - RETAIL
El 0000004 FRAMELIM CREDIT SOLUTIONS 00003 - STUDENT LOAMS
El 0000014 EEY FINANCIAL CORP 00003 - STUDENT LDAMNS
El 0000001 Portfolio 1 00000 - GEMERAL CLASS OF BUSIMES
ﬂ 0000002 Paitfelio 2 00000 - GEMERAL CLASS OF BUSIMES
=l 0000Mm3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
El 0000003 FORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSIMES
E'J 000000s PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSIMES
El (000010 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSINES
El 0000008 Smaltbossn Bank: 00000 - GEMERAL CLASS OF BUSIMES
| | 0000012 SODIM 210 00000 - GEMERAL CLASS OF BUSINES
El 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
El 0noat1 S0o0IM s291 00000 - GEMERAL CLASS OF BUSIMES

I

Cancel

ok

From the menu bar, click New Group. The New Custom Group dialog box appears.

i Mew Custom Group ﬁ

Custom Group's |D [30 Char]

Custom Group's ID (30 Char): Unique code that identifies the customer group. The ID can be up
to 30 characters in length.

Custom Group's Description (100 Char - Optional): Description of the customer group, up to 100

characters in length.

Complete the information and then click OK.

To assign a customer to the customer group, see Add a Customer to a Customer Group.

Related Topics

Customer Groups

Feedback

14
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Modify a Customer Group

Use the Edit Customer Group dialog box to modify a customer group.
To modify a customer group

4. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

# Customer Groups = | e

ﬂ MNeww Grougp .i," Refresh # search
_EFM Code | Mame [ Dlass
= Banks - Banks IF] 0000003 BOBS HARLEYS 00001 - RETAIL
-] 0000006 - Smelkown Bank C|E] 0000000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
- Coedit Card Customess - Credit C2 | 551 (1000005 Famers Bank 00007 - RETAIL
i Schooks - Schools i) 0000004 FRAMKLIN CREDIT SOLUTIONS 00003 - STUDEMNT LOAMS
] 0000014 KEY FIMANCIAL CORP 00003 - STUDENT LOWNS
] 000000 Portfio 1 00000 - GEMERAL CLASS OF BUSINES
m Q0oo0002 Potfclio 2 00000 - GEMERAL CLASS OF BUSINES
L] 00mm3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
E 0000003 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES
DODO00S PORTFOLID EXCEL 00000 - GEMERAL CLASS OF BUSIMES
L] 000010 PORTFOLIO Fix 00000 - GEMERAL CLASS OF BUSINES
IF] 0000008 Smalkown Bark 00000 - GEMERAL CLASS OF BUSINES
L] oooooiz SODIN 8210 00000 - GEMERAL CLASS OF BUSINES
] 0000007 SODIN 629 00000 - GEMERAL CLASS OF BUSINES
m Qoooo11 S00DIM 2291 00000 - GEMERAL CLASS OF BUSINES
P | = k| . P | = 1

e Inthe Navigation pane, right-click the customer group to modify and then click Edit. The Edit
Custom Group dialog box appears.

ﬁ! Edit Custorn Group (Barnks) |
Cuztam Group's [D |30 Char)
Banks |
Custom Group's Descriphan 100 Cha- Optional]
|Banks

Cancel S aYE

Custom Group's ID (30 Char): Unique code that identifies the customer group. The ID can be up
to 30 characters in length.

15



Customers
Custom Group's Description (100 Char - Optional): Description of the customer group, up to 100
characters in length.
5. Modify the information as necessary and then click Save.
Related Topics

Customer Groups

Feedback

S GENESYS

Delete a Customer Group

Use the Customer Groups window to delete a customer group.
To delete a customer group

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

# Customer Groups = | [

ﬂ MNeww Grougp .i," Refresh # search

_gim Code | Name [ Case

= Banks - Banks IE] 0000003 BOBS HAALEYS 00001 - RETAIL

- -] 0000006 - Smelkown Bank C|E] 0000000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS

- Coedit Card Customess - Credit C2 | 551 (1000005 Famers Bank 00001 - BETAIL

(-1 Schools - Schools i) 0000004 FRAMKLIN CREDIT SOLUTIONS 00003 - STUDEMNT LOAMS
W] 0000014 EEY FIMANCIAL CORP 00003 - STUDENT LOBNS
EI Q0oonom Paotfohio 1 00000 - GEMERAL CLASS OF BUSINES
ﬂ Q0oo0002 Potfclio 2 00000 - GEMERAL CLASS OF BUSINES
L] 00o0m3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSINES
El 0000003 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES
0] oDo00CE PORTFOLID EXCEL 00000 - GEMERAL CLASS OF BUSINES
L] 000010 PORTFOLIO Fix 00000 - GEMERAL CLASS OF BUSINES
IE] 0000008 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
L] oooooiz SODIN 8210 00000 - GEMERAL CLASS OF BUSINES
[F]  00moo7 SODIM &9 00000 - GEMERAL CLASS OF BUSIMES
El Qoooo11 S00DIM 2291 00000 - GEMERAL CLASS OF BUSINES

2. Inthe Navigation pane, right-click the customer group and then click Delete Group. The Delete
Custom Group dialog box appears.

3. Click Yes and in the next dialog box, click OK. The Invoices program deletes the customer group.
The customers associated to the group remain in the system.

Related Topics
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Customer Groups

Feedback

S GENESYS

Modify Customer Group Settings

Use the Customer Groups window to modify customer group settings.
To modify customer group settings

4. In the Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

(Mmoo T T =

ﬂ Meww Groug .e Refresh i Search
_ETM Code [ Name [ Dase
() Banks - Banks [F]  0DIOD0E BOBS HAALEYS 00001 - RETAIL
- -] 0000006 - Smalkown Bank | ¥ 0pooon0 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
8- Credit Card Customess - Credit C2 | F5) 000008 Famers Bank 00007 - RETAIL
-0 Schooks - Schools [E] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
= 0000014 EEY FINANCIAL CORP 00003 - STUDENT LOAMS
El 0000001 Portfolio 1 00000 - GEMERAL CLASS OF BUSIMES
IE]  oomo002 Pottclio 2 00000 - GEMERAL CLASS OF BUSIMES
=l 0000Mm3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
g 0000008 FORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSIMES
OO0000S FORTFOLID EXCEL 00000 - GEMERAL CLASS OF BUSINES
[ | 0000Mmo PORTFOLIO Fix 10000 - GEMERAL CLASS OF BUSIMES
IE] 000000 Smaltown Bari 00000 - GEMERAL CLASS OF BUSIMES
| | 0000012 S0DIN &210 00000 - GEMERAL CLASS OF BUSINES
El 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
£]  ooooon SODIN 2291 00000 - GEMERAL CLASS OF BUSIMES
P | = 1 n .l = 1

5. Inthe Navigation pane, click a customer group. The customer group settings appear in the
Information pane.
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Customers

m

g Mew Group i? Refresh # cearch

E:I Al Customers
218w | Banks - Barks
&) Credt Card Customers - Credt Cz
-] Schoc: - Schools

Banks - Banks

[~ Dizplay Group on Statistics Console
[~ Display Group in Imvoice apphcation

Eu&|ng | Class
] 0000005 Smaliown Bank D000 - GEMERAL CLASS OF BUSINES

Display Group on Statistics Console: If selected, the customer group is available for selection in
Statistics Console.

Display Group in Invoice application: If selected, the customer group is available for selection in
Invoices.

e Inthe Information pane, complete the information. The Invoices program saves your
changes instantly.

Related Topics

Customer Groups

Feedback

S GENESYS

Add a Customer to a Customer Group

Use the Customer Groups window to add a customer to a customer group.
To add a customer to a customer group

6. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.
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i Customner Groups = | E e

Q MNew Groug e Refresh H Search

_gl-m Code | Mame | Class

() Banks - Banks [F]  0DIOD0E BOBS HAALEYS 00001 - RETAIL

- -] 0000006 - Smalkown Bank | ¥ 0pooon0 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS

8- Credit Card Customess - Credit C2 | F5) 000008 Famers Bank 00007 « RETAIL

- Sichooks - Schools €] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOANS
= 0000014 EEY FINANCIAL CORP 00003 - STUDENT LDAMNS
] 000000 Porttoio 1 00000 - GEMERAL CLASS OF BUSINES
] 00mome Porigio 2 00000 - GEMERAL CLASS OF BUSINES
=l 0000Mm3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000008 PORTFOLIO DELMITED 00000 - GEMERAL CLASS OF BUSIMES
] 0000DOS PORTFOLID EXCEL D000 - GEMERAL CLASS OF BUSINES
|| (000010 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSINES
] 0000005 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
o] 00000tz sODIM E210 00000 - GEMERAL CLASS OF BUSINES
El 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
) ooooot1 sODIN E291 D000 - GEMERAL CLASS OF BUSINES

e In the Navigation pane, click All Customers. All customers in the system appear in the
Information pane.

¢ Inthe Information pane, click a customer, and then drag and drop it onto a customer group in
the Navigation pane.

e Do one of the following to select multiple customers to drag and drop onto a customer group:

1. To select contiguous customers, click the first customer to select, hold down the Shift
key and click the last customer to select. Drag and drop the customers to the customer
group.

2. To select non-contiguous customers, click the first customer to select, hold down the
Ctrl key and click each additional customer to select. Drag and drop the customers to
the customer group.

Related Topics

Customer Groups

Feedback

S GENESYS

Modify a Customer in a Customer Group

Use the Customer Groups window to modify a customer.

To modify a customer in a customer group
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2.

3.

Customers

In the Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups

window appears.

ﬂ MNeww Groug e Refresh

T e )

c] E Banks - Banks

L) 000000 - Smalkown Bank
(-0 Credit Card Customess - Credit Cz
-0 Schods - Schools

" Search
Code | Mame | Class

[F]  0DNOODE BOBS HARLEYS 00007 - RETAIL
&] 0000000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
IEl 0000005 Famers Bank 00007 - RETAIL
IE] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
| 0000014 EEY FIMANCIAL CORP 00003 - STUDENT LOAMS
] ooo00m Portioio 00000 - GEMERAL CLASS OF BUSINES
IE]  oomooz Ponfoic 2 00000 - GEMERAL CLASS OF BLSINES
] oo0om3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSINES
%l 0000008 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES

OO0OO0E PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSINES
] oooomo PORTFOLIO Fi 00000 - GEMERAL CLASS OF BUSINES
IE] 000000 Smaltown Bari 00000 - GEMERAL CLASS OF BUSINES
] 0000012 SODIN E210 00000 - GEMERAL CLASS OF BUSINES
El 0000007 S00IN 829 00000 - GEMERAL CLASS OF BUSIMES
] oomoon sooiN &9 00000 - GEMERAL CLASS OF BLUSINES

In the Navigation pane, click a customer. The customer information appears in the Information

pane.

Modify the information as necessary and then click OK.

g Mewe Group e Refresh “ Search
E Al Cushomers
-0 Banks - Barks EﬂmdlAmﬂllekmlml info | Desk Distrivution | Comments | Custon |
G (8 | L0006 - Smalhiovn Bank,

[0 Coedit Card Customess - Credit Ca et 000D00G Stafuiz P’UM =l

E-[J Schook - Schooks dlpha Code | |
Hame |Smalkown Bank |
Addiess | 3800 METERIE AVENUE |

| |
City/State/Zp  [VACKSONVILLE |[FL |[3zz4a |
Carlact [PaM BRIGGS |
Proe 304558360 | |
EmailAddress | |
ousinees L]
Py E_ H
oK Cancel I Appl
I
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Related Topics

Customer Groups

Feedback

S GENESYS

Delete a Customer from a Customer Group

Use the Customer Groups window to delete a customer from a customer group.
To delete a customer from a customer group

5. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

& Customner Groups = | B[

Q MNeww Grougp e Refresh @ search
_Efm Code [ Hame [ Case
(= ] Banks - Banks [F]  0D0ODOE BOBS HAALEYS 00001 - RETAIL
- "I 0000006 - Smalkown Bank | ¥ 0po0op0 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
- Coedit Card Customess - Credit C2 | 551 000005 Famners Bank 00001 - RETAIL
-0 Schooks - Schools i) 0000004 FRAMKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
|| 0000074 EEY FIMANCIAL CORP 00003 - STUDENT LOAMNS
El 0000001 Portfolio 1 00000 - GEMERAL CLASS OF BUSIMES
]  oooooz Paniic 2 00000 - GEMERAL CLASS OF BUSINES
=l 0000Mm3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
El 0000002 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES
OO0000S FORTFOLID EXCEL 00000 - GEMERAL CLASS OF BUSINES
| 0000M0 PORTFOLIO FE< 00000 - GEMERAL CLASS OF BUSIMES
] 0000008 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
|| 0000012 S0DIN &210 00000 - GEMERAL CLASS OF BUSINES
El 0000007 SO0 829 00000 - GEMERAL CLASS OF BUSINES
©]  ooooot1 soDIM E29t 00000 - GEMERAL CLASS OF BUSINES
P | = 1 n .l = 1

1. In the Navigation pane, right-click the customer and then click Remove Customer. The Invoices
program deletes the customer from the customer group. The customer remains in the system.

Related Topics

Customer Groups
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Feedback
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Invoices

Use the Invoices window to specify settings and generate invoices for a customer or group of customers.
Related Topics

Generate an Invoice for a Specific Customer

Generate Invoices for a Group of Customers

Undo the Last Invoice Generated

Undo a Specific Invoice

Reprint an Invoice

Specify Default Invoicing Options

Modify the Invoicing Frequency

Report Viewer

Feedback

S GENESYS

Generate an Invoice for a Specific Customer

Use the Invoice Options dialog box to specify what information to include on the invoice and then
generate the invoice for a specific customer. Before generating invoices, confirm that you processed all
payment batches.

Note: For customers associated to a parent customer (subsidiaries), The Invoices program only
generates invoices for the parent customer.

To generate an invoice for a specific customer

2. Inthe Invoices window, in the Navigation pane, right-click a customer and then click Invoice
Customer. The Invoice Options dialog box appears, with the customer name and number at the
top.
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Invoice Options .
0000004 - ABC CUSTOMER
liveics Dabe

Payment Date Rangs
* Inchude ol uninvoeced payments
™ Inchude papments with entesed date range of;

=] - [ =]
Ditect Paymenls
~ Bypazs Diect Payment: and do nol include them on
© the Irvoice

(% Inchade Direct Payments
Match PUR: [Exchade bicm lnvoics)
[ Match the Reverzal with the Papment thal was peversed

= Match the R eversal with any matchng payment fior the
same account

Shaterrmrt
[ Prirk Statement with Irvoice

—

Preview |  Epot | Pais | [TTaned |

Invoice will be dated: Date to appear on the invoice. The date defaults to the current date. To
change the date, click the arrow and then click a date in the calendar.

Include all uninvoiced payments: If selected, the invoice includes all payments that your
organization hasn't invoiced.

Include payments with entered date range of: If selected, the invoice only includes payments
and adjustments within the specified date range that your organization hasn't invoiced. Specify
the date range or accept the default, which includes all payments and adjustments since your
organization last created an invoice for this customer. The first box is the beginning date and the
second box is the ending date.

Bypass Direct Payments and do not include them on the invoice: If selected, the invoice doesn't
include payments made directly to the customer.

Include Direct Payments: If selected, the invoice includes payments made directly to the
customer.

Match the Reversal with the Payment that was reversed: If selected, the invoice doesn't include
reversals that the Invoices program matches to a reversed payment.

Match the Reversal with any matching payment for the same account: If selected, the invoice
doesn't include reversals that the Invoices program matched to any matching payment for the
same account.

Note: If you select both check boxes, the Invoices program matches the reversal to the reversed
payment as long as your organization hasn't invoiced the reversed payment. If your
organization invoiced the reversed payment but hasn't invoiced the make-up payment, the
Invoices program matches the reversal to the make-up payment. If you clear both check boxes,
the invoice includes all payments and reversals.



Print Statement with Invoice: If selected, the Invoices program prints a customer statement

along with the invoice.

Print Statement even if Invoice has no items: If selected and the invoice doesn't have any line

Invoices

items, the Invoices program prints a customer statement. If cleared and the invoice doesn't have
any line items, the Invoice program doesn't print a statement.

3. Complete the information.

4. To preview the invoice, do the following:

1. Click Preview. The invoice displays in the Invoice [Customer Code][Invoice Number] -

Latitude Report Viewer window.

®) Invoice [0000002]{10003] - Latitude Report Viewer (= | o
Bepot  Mew Window Hep
Trrvioece [COOC002] 10003 |
P o -
Invoice Number: 10003 CIDERSYSTEST PrintDate: 412019
Page1ofl
7800 Belfort Parkway
Sudte 100
00002 SECOND CUSTOMER Jacksomville, FL. 32256
123 SOMEWHERE PLAZA S04-680-7100 Fax: S04-580.7139
JACKSONVILLE, FL 322215
Am: MIKE IevoiceDaw: 412015
Name Aczcount Number Code| PayDaw Paid Te Us Paid Te You OurFee Pt Less Fee -
5455001803115576 212009 200.00 6000 130,00
Same  £80034
Tavoice Totals 200.00 60.00 140.00
Dras Us:
Total Collections
Due You:
< [ |
Current Page Mo 1 Total Page No.: 1 Zoom Factor: Page Width

Note: This window provides several options, such as exporting and printing. For more

information, see Report Viewer.

1. Close the window.

1. To export the invoice, do the following:

1. Inthe Invoice Options dialog box, click Export. The Browse For Folder dialog box

appears.

2. Select the folder to save the file to and then click OK. The file naming convention is,

"Invoice [Customer] [Invoice Number]". If you selected the Print Statement with Invoice
check box, the Invoices program generates a statement also. The file naming convention
is, "Statement [Customer] [datetime stamp]".

2. To print the invoice, do the following:

1. Inthe Invoice Options dialog box, click Printer. The Print dialog box appears.

2. Select a printer and then click Print.
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When you are finished previewing, printing, or exporting the invoice, the Status of Invoices

window appears.

Statuz of Invoices

Stahuz

i ] Dhe Cust

Irvwoic

O000006-CUSTOMER FOLUR

Generated 10003

F3ET5

30,00 LSO

1 Itemes Processed

3. Click the X to close the window. The Invoices program updates the Summary of Invoices tab in
the Invoices window to include the invoicing information.

-
E[muiu:s
Actions Tools View

g 0000O00-DEFALLT
g 0000001-CUSTOM
& 0000002-CUS TOM
e O000003-POD CUS

& 0000004-CUSTOM
g O000005-DILALER T

O00000E-CUSTOM
0000007-FIRST CL
0000008-SECOND
0000003 THIRD CL

o 00DO010-DISNEY [
- g 0000011-4BC Custe
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| = X
Reports
Eﬁltustumets Summary of Imoices Isumgpufupenlbgms]

0000006 - CUSTOMER FOUR [US Dollar)

rvoice Frequency.  MONTHLY

MMaM MET View Date Flange

rremce Type: COMBINED

Soit Items By ACCOUNT NUMBER l6/32012 =] w [a/1172m3 -]

Last Invoece Apri 11,2013

Last Invoice Altempt Apr 11, 2013

Summary of Invoices for 0000006 - CUSTOMER FOUR - (USD]
Invoice Gross Collections Fees Summary
Irneaice Date | Sps Mo Paid Usg I Paid Cust Total Prits Eamed Dige U Due Cust
10003 041113 | 0413 49.00 0.00 43,00 1225 0.oo xS

| Selected: "0000006-CUSTOMER FOUR"

10:11 &M

a3,




Invoices

e Toview summary information for an individual customer, in the Navigation pane, click the
customer.

Related Topics

Invoices

Feedback

S GENESYS

Generate Invoices for a Group of Customers

Use the Invoice Options dialog box to specify what information to include on the invoices and then
generate invoices for the specified group of customers.

Note: The Invoices program only invoices customers associated to a parent customer (subsidiaries)
under the parent customer.

To generate invoices for a group of customers
e In the Invoices window, do one of the following:

o To generate invoices for all customers, from the View menu, click All Customers. In the
Navigation pane, click All Customers.

e To generate invoices for customers that your organization invoices monthly, from the View
menu, click Monthly Customers. In the Navigation pane, click All Monthly Customers.

e To generate invoices for customers that your organization invoices weekly, from the View
menu, click Weekly Customers. In the Navigation pane, click All Weekly Customers.

e To generate invoices for customers that your organization invoices on demand, from the
View menu, click On Demand Customers. In the Navigation pane, click All On Demand
Customers.

e To generate invoices for customers in the default customer group, from the View menu,
click Default Group. In the Navigation pane, click Default Group.

e To generate invoices for customers in a specific customer group, from the View menu, click
the group name. In the Navigation pane, click the group name.

e  From the Action menu, click Invoice All. The Invoice Options dialog box appears, with
the name and number of the first customer in the group at the top.

26


file:///c:/builds/latitude_latitude.2022r2_systest/products/Documentation/Source/Invoices_Help/javascript:%7bmail_str%20=%20%22mailto:LatitudeDoc@genesys.com

Invoices Printable Help

27

Invoice Options .
- DEFALLT CUSTOMER
Inncace Diate
Irevoice will be dated: (Sslect date) | 47129 -
Papment Dabe Range

% Inchade all unirvoced payments
" Inchade papmerds with entered date 1ange of

Dwect Papments
~ Bypass Diect Payments and do not inchsde them on
Hhee |nevioice

{* Include Dinect Payments

Match PLRS [Exchede from Irvosce]
W Makch the Reversal with the Papment that was ieverped

= Match the Reversal with anw matching pavment for the
samé sccount

Slatement
[T Print Statement with Invoice
=

Preview |  Expot | Prkes Cancel |

[T Use these seftings for ol Invosces in this iun

Invoice will be dated: Date to appear on the invoice. The date defaults to the current date. To
change the date, click the arrow and then click a date in the calendar.

Include all uninvoiced payments: If selected, the invoice includes all payments that your
organization hasn't invoiced.

Include payments with entered date range of: If selected, the invoice only includes payments
and adjustments within the specified date range that your organization hasn't invoiced. Specify
the date range or accept the default, which includes all payments and adjustments since your
organization last created an invoice for this customer. The first box is the beginning date and the
second box is the ending date.

Bypass Direct Payments and do not include them on the invoice: If selected, the invoice doesn't
include payments made directly to the customer.

Include Direct Payments: If selected, the invoice doesn't include payments made directly to the
customer.

Match the Reversal with the Payment that was reversed: If selected, the invoice doesn't include
reversals that the Invoices program matches to a reversed payment.

Match the Reversal with any matching payment for the same account: If selected, the invoice
doesn't include reversals that the Invoices program matched to any matching payment for the
same account.

Note: If you select both check boxes, the Invoices program matches the reversal to the reversed
payment as long as your organization hasn't invoiced the reversed payment. If your
organization invoiced the reversed payment but hasn't invoiced the make-up payment, the
Invoices program matches the reversal to the make-up payment. If you clear both check boxes,
the invoice includes all payments and reversals.



Print Statement with Invoice: If selected, the Invoices program prints a customer statement

along with the invoice.

Print Statement even if Invoice has no items: If selected and the invoice doesn't have any line

Invoices

items, the Invoices program prints a customer statement. If cleared and the invoice doesn't have
any line items, the Invoice program doesn't print a statement.

Use these settings for all Invoices in this run: If selected, the Invoices program applies these

settings to all the customers. If cleared, the Invoices program displays the Invoices Options dialog
box for each invoice to allow you to specify settings for each customer.

e Complete the information.
e To preview the first invoice in the group, do the following:
e C(Click Preview. The invoice displays in the Invoice [Customer Code][Invoice Number]
- Latitude Report Viewer window.
E Invoice {0000002)[10003] - Latitude Report Viewer = | o
Bepot  Mew Window Help
[ Trvcica 0000002 10003]
R S| TR N -
:I:;::l-;u.-bm 10003 CIDERSYSTEST PrintDate: 412019
B 7800 Belfont Parkvway
Sueite 100
Q00002 SECOND CUSTOMER Tacksomvills, FL 32256
123 SOMEWHERE PLAZA S04-680.T100 Fax: 04-680.7136
JACKSONVILLE FL 32215
Am: MIKE IevoiceDat: 412019
Name Account Number Code Fay Date Paid To Us Paid To You Our Fee Pmt Less Fee =
DOD;]I_I._E_;‘EFE 5458001803115876 4 19 200.00 60.00 130.00

4

Samcw  EAP02¢

Tnvoice Totals

200.00

60,

0o

14000

D Ts:
Total Collections
D You:

§0.00

200.00

Current Page Mo 1

1. Close the window.

2. Toview the next invoice, close the window and, in the Invoice Options dialog box, click Preview.

Total Page Mo 1

Zoom Factor: Page Width

1. To export the first invoice in the group, do the following:

2.

Note: This window provides several options, such as exporting and printing. For more
information, see Report Viewer.

In the Invoice Options dialog box, click Export. The Browse For Folder dialog box appears.

3. Select the folder to save the file to and then click OK. The file naming convention is, "Invoice

[Customer] [Invoice Number]". If you selected the Print Statement with Invoice check box,
the Invoices program generates a statement also. The file naming convention is, "Statement
[Customer] [datetime stamp]".
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To export the next invoice, in the Invoice Options dialog box, click Export.

To print the first invoice in the group, do the following:

4
5
6. Inthe Invoice Options dialog box, click Printer. The Print dialog box appears.
7. Select a printer and then click Print.

8

To print the next invoice, in the Invoice Options dialog box, click Printer.

When you are finished previewing, printing, or exporting the invoices, the Status of Invoices
window appears.

Status of Invoices
Customes | Sratus Irrvoice DueCust | Duels | Cumency
b | DODOOOO-DEFALLT CUSTOMER | Mo e Mot lrreoiced
0000002-SECOMD CUSTOMER | Generated 10009 $200.00 $60.00| USD
0000004-4BC CUSTOMER | Mo Iheens Mot Irvosced |
5 Items Procassed P

1. Click the X to close the window. The Invoices program updates the Summary of Invoices
tab in the Invoices window to include the invoicing information.
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OOOO0O0-DEFALILT
OOOOOT FIFST CL ANl Customers
DO0O00Z-SECOND : 1
QKON THIRD £ |
OO0O04-ABC CLIS I Ve (oo R
1 [vmmms =] o [as12m =]
......................................................... |
|
|
Irrerica (Gezan Colschions Feet Smmary -
roce | Date [Spbo] PsdUs [ PsdCit | TowiPmis | Eamed Duels | DueCus
1000 (43| A 000 000 WO00 15000 o 1500
00 | MANATE] A | 10000, 0| 0K S0 5000 10000
-
" > 7
Customer Group Setschad "4l Customen™ 259PW | anams

1. Toview summary information for an individual customer, in the Navigation pane,
click the customer.

Related Topics

Invoices

Feedback

3 GENESYS

Undo the Last Invoice Generated

Use the Invoices window to undo the last invoice generated. This option allows you to correct items on
an invoice and then regenerate the invoice. If you generated invoices for a group of customers, the
Invoices program reverts the last invoice in the group. You can repeat these steps to undo as many
invoices as necessary. To undo a specific invoice, see Undo a Specific Invoice.

To undo the last invoice generated

a. Inthe Invoices window, from the Actions menu, click Undo Last Invoice. A confirmation dialog
box appears.
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(Mingo kot A [

Undo Invoice 10003
Dated 4/11,/2013
Custormer 00000067

e ]

— Click Yes. A notification dialog box appears.

— Click OK.
Related Topics

Invoices

Feedback

S GENESYS

Undo a Specific Invoice

Use the Summary of Invoices tab in the Invoices window to undo a specific invoice. This option allows
you to correct items on an invoice and then regenerate the invoice. Undoing an invoice doesn't undo
checks that you printed. If you printed checks, delete them from the check register. For more
information, see Delete a Transaction From the Check Register.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To undo a specific invoice

¢ Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for
which to display invoices.

e Click the Summary of Invoices tab.
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1.
2.

Invoices

DOOOOOCHE FALILT

DOO000T-FIFST CL ANl Customers
DOOO00Z-SECOND
OO0 THIRD £
DOOO00M-ABC CUIS Wiarer [ate o
[vmmms =] o [as12m =]
Consoldabed Summany of irrvoxces bor A Cuslomens - [UIS0)
Irrerica (Gezan Colschions Feet Smmary -
roce | Date [Spbo] PsdUs [ PsdCit | TowiPmis | Eamed Duels | DueCus
1000 [amAE| A | 000 000 WO0F 15000 o) 1500

Cumtomer Group Sedected "l Customen™ Z259PW anams

To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

In the data grid, right-click the invoice and then click Undo Selected Invoice. The Undo Invoice(s)
dialog box appears.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice. Click Undo All Selected.

Are you sure you want to undo:

1 Irnvoice(s)

=]

Click Yes. A notification dialog box appears.

Click OK.

Related Topics

Invoices

e e |
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S GENESYS

Reprint an Invoice

Use the Summary of Invoices tab in the Invoices window to reprint an invoice.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To reprint an invoice

1. In the Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Invoices tab.
OOOOOOHEFALILT
D0 -FIRES T CL Al Customars
DODO0CZ-SECOND [ )
OO0 THIRD IC1 4
DOOOD04-AEC CLUIS | WVarer [t Flarson
; [imems =] w [471/7m3 =]
T T e s S T g b
Irregice {Geoan Collechions Fess Smmary -
Woice | Date [Spis] Psdls | PsdCst | TowlPms | Esmed Duslls | DusCum
| V000 A3 AT 000 00 00 00 15000 (] 150000
WE | ] 049 | 1000, 000 WOON 5000 500/ 10000
- > o
Cumteenar Groug Selactad "0l Customesn” 259 P 4N/
1. To change the date range for which to display invoices, click the arrow next to the date range

boxes and click a beginning and ending date.
2. In the data grid, right-click the invoice and then click Reprint Selected Invoice.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice. Click Reprint All Selected.

1. Do one of the following:

2. To preview the invoice before reprinting, click Preview. The invoice appears in the Report
Viewer window. For more information, see Report Viewer.
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3. To print the invoice without previewing it first, click Printer.
Related Topics

Invoices

Report Viewer

Feedback

S GENESYS

Specify Default Invoicing Options

Use the Options dialog box to specify default invoicing options for your agency. These settings apply
globally.

To specify default invoicing options

1. From the View menu, click Options. The Options dialog box appears.
E| Options | x|
Customers with balances: due
¥ Adpst Remittance Checks, I Apply To Oldest First

“When an Invoice i created, if the Custamer has outstanding Open lbems due, offsst
ary check o be created by the amaunt due from the Customer

— Papment Data Salechion
* Select by the Papment Entered date.
™ Select by the Papment Date-Faid date. (Mot recommended]

—Reversal Matching

[ Match Aeverzals with e onginal payment and do not irvoice either papment.
[w Match Reveizals with B papmernt that covers it
It both boses ame checked the reverzal will be matchad wath the onginal papment az long as the
onginal pasment has not been invaiced. IF the aigingl papment has been irvoiced the program
will mateh B pesverzal with e make-up pagpement i thal has nol pet been irmaicad.
~Logging
[T Enable Legging

SaveOptions | Eat |

Adjust Remittance Checks: If selected, the Invoices program deducts from the checks created in
the Invoices program the outstanding open items due from customers. The Invoices program
reduces the invoice totals by the amount applied to outstanding accounts receivable items and
prints another summary line on invoices to show the amount applied.

Apply to Oldest First: If selected, the system applies payments to the oldest accounts receivable
balance first. This option is available when you select the Adjust Remittance Checks check box.

Select by the Payment Entered Date: If selected, the invoice includes payments based on the
date a user added the payment to Latitude.
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Select by the Payment Date - Paid date: If selected, the invoice includes payments based on the
date paid.

Match Reversals with the original payment and do not invoice either payment: If selected, the
Invoices program matches reversals to the reversed payment and doesn't invoice either
transaction.

Match Reversals with the payment that covers it: If selected, the Invoices program matches
reversals to any matching payment for the same account and doesn't include them on invoices.

Note: If you selected both check boxes, the Invoices program matches reversals to the original
payment as long as your organization hasn't invoiced the original payment. If your organization
invoiced the original payment and hasn't invoiced the make-up payment, the Invoices program
matches the reversals to the make-up payment. If you cleared both check boxes, the invoice
includes all payments and reversals.

Enable Logging: If selected, the Invoices program creates the "Invoices.log" file in the C:\Program
Files (x86)\Interaction Collector\AuditLogs directory. It contains any error messages generated in
the Invoices program. You can send this file to Latitude by Genesys Support for assistance in
troubleshooting invoicing issues.

1. Complete the information and then click Save Options.
Related Topics

Invoices

Feedback

S GENESYS

Modify Invoicing Options

Use the Customer Properties window to modify a customer's invoicing options.
To modify invoicing options

1. In the Invoices window, in the Navigation pane, right-click a customer and then click Properties.
The Customer Properties window appears.
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General | Account | Fees | mvoice | Services | Wfo | Desk Distribution | Comments | Custom |

Code 0000001 Stahss [ACTIVE
AlphaCode |
Mame |CUSTOMER OME
Addrass |123HNH STREET

[SLITE 100
Ciw/Staie/Zip  |[/ACKSOMVILLE [[FL | |z2248

Conlacl [MATT
Phone [#51212 | Fau

Email Address | barbara martin@inin.com

ouasiomen ]
Prioiity I

1. Click the Invoice tab.

Services | Wfo | Desk Distrivution | Comments | Custom |
Parent Customer [D00D00T - CUSTOMER ONE El

Iresice Type |2 -COMEINED LI ¥ Show Date Received

Irrvoice Fr |z MONTHLY ;l [T Show Othes Mame
[ Show &maourt Due Client
=
¥ Show Cumment Balance
[ Show Origingl Dale on Reversal:

Invaice Method |1 -NET
Irwoice Sot |2-CUSTOMER ACCOUNT |

Remi Method  |Check =

Mumbes of das to allw papments by check bo clear Iu—_d

bezfiore irchuding them on an invoice
~ Crystal Repot Associstions
Invoice Flepot | Basiclnvoice ot =l

=z

Parent Customer: If your organization bills the customer as part of a parent company, click the
folder to select a customer group.

Invoice Type: Determines the invoicing method for payment types.
1. Separate: Creates separate invoices for each payment type.

2. Combined: Includes all payment types together (combined) in one invoice.
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Note: If you set the Invoice Type to Combined, PC (direct), the Invoices program includes
payments in the fees withheld. If you set the Invoice Type to Separate, PC (direct), the Invoices
program creates payments as open items for the invoice.

Invoice Frequency: Determines how often to send invoices to the customer.
Invoice Method: Method for invoicing the customer.
1. Net: Subtracts your organization's fee from the customer invoice.

2. Gross: Sends customer invoices with all monies included. The customer pays your fee
based on the invoice information.

Invoice Sort: Order to sort the invoices.

Remit Method: Determines the method for remitting invoices. Invoice transactions appear in the
check register automatically for customers with a remittance method of "check" or "ACH
transfer." If the remittance method is "manual," add the invoice transactions to the check register

manually.
1. Manual: Your agency manually generates checks for the customer.
2. Check: Your agency uses the Invoices program to print checks for the customer.
3. ACH Transfer: Your agency uses the Invoices program to create ACH wire transfers for

the customer.
Show [check boxes]: If selected, the corresponding information prints on the customer's invoices.

Number of days to allow payments to clear before including on invoice: Number of days to wait
before including debtor payments on a customer invoice. If the debtor’s check does not clear, use
this option to avoid sending payment information to a customer.

Invoice Report: Crystal Reports file to use when creating invoices for the customer. This option
allows you to use custom invoices for each customer. The default file is Basiclnvoice.rpt.

1. Modify the settings as necessary and then click OK.
Related Topics

Invoices

Feedback

S GENESYS

Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

1. Generate a report.

2. Generate or reprint an invoice.
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3. Preview a statement.

The following example is for a report.

Invoices

Dy e M )
P S 1 n o
Summary of Invoices
All customers for system month 042013 |
Report Date: 4/11/2013 1
Invoice(s) Paid Us Pasd Cust  Collections Fess DueUs Due Cust Currency
0000001 CUSTOMER ONE 10004 4.460.88 0.00 446088 111522 0.00 334566 USD
0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 12.25 0.00 3675 USD
4,500.88 0.00 450988 112747 0.00 338241
@ n F )
Current Page No.: 1 Total Page No.: 1 Zoom Facter: Page Width
Icon Description
E Exports the report to a file.
‘3 Prints the report.
L Displays the first page of the report.
4 Displays the previous page of the report.
3 Displays the next page of the report.
4 Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
iy Opens the Find Text dialog box to allow you to search for text within the report.
i Increases or decreases the text size when viewing the report on your monitor. Changing the
text size here does not affect the size of the text on the printed report.

Related Topics

Reports

Invoices
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Feedback

S GENESYS

Statements

Use the Invoices window to preview and print account statements for a customer or group of
customers. Account statements show a customer's receivables by invoice.

Related Topics

Generate a Statement for a Specific Customer

Generate Statements for a Group of Customers

Report Viewer

Feedback

S GENESYS

Generate a Statement for a Specific Customer

Use the Report Viewer window to generate a statement of account for a specific customer.
To generate a statement for a specific customer

1. In the Invoices window, in the Navigation pane, right-click the customer and then click
Generate Statements.

2. Do one of the following:

1. To preview the statement before printing it, click Preview. The statement of account
appears in the Report Viewer window.
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Statements

Interactive Intelligence, ARM Division
7800 BELFORT PARKWAY
SUITE 100

UITE 1
JACKSONVILLE, FL 32236

Statement of Account
CustomerMNumber: 0000001 Statement Date:  April 11, 2013

iﬁf&%‘i ONE For Customer Trquifies covtact:

123 MAIN STREET Phone; 904-680-7100

SUITE 100 Toll Free: 866-306-2500
JACKSONVILLE, FL 32246

Summary or Items by Age:
Less than 30 days old
311060 daysold
61 to 90 davs ald
Over 90 davs old

Total Am ount Due:

< | ]

Current Page No.: 1 [Total Page No.: 1 |Zoom Factor: Page Width

For more information about using the Report Viewer window, see Report Viewer.

1. To print the statement without previewing it first, click Print. The statement of account is output
to your default printer.

Related Topics

Statements

Report Viewer

Feedback

3 GENESYS

Generate Statements for a Group of Customers

Use the Report Viewer window to generate account statements for a group of customers.
To generate statements for a group of customers
1. In the Invoices window, do one of the following:

1. To generate statements for all customers, from the View menu, click All Customers. In
the Navigation pane, click All Customers.
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2. To generate statements for customers that your organization invoices monthly, from
the View menu, click Monthly Customers. In the Navigation pane, click All Monthly
Customers.

3. To generate statements for customers that your organization invoices weekly, from the
View menu, click Weekly Customers. In the Navigation pane, click All Weekly
Customers.

4. To generate statements for customers that your organization invoices on demand, from
the View menu, click On Demand Customers. In the Navigation pane, click All On
Demand Customers.

5. To generate statements for customers in the default customer group, from the View
menu, click Default Group. In the Navigation pane, click Default Group.

6. To generate statements for customers in a specific customer group, from the View
menu, click the group name. In the Navigation pane, click the group name.

1. From the Action menu, click Generate Statements.
2. Do one of the following:

1. To preview the statement before printing it, click Preview. The account statements
appear in the Report Viewer window. A tab appears in the window for each customer
statement.

rdj Statement for 0000011 - Report Viewer [
Fepot  View Window Help
Statement for 000005 | Statement for 0000007 | | )
Statement for 0000008 | Statement for 0000010 Siadement for 0000001 | Statement for 0000003 | Statement for 0000004 | Stabement for 0000005
@ 3| Mg : / i -
Interactive Intelligence, ARM Division |
TR00BELFORTPAREWAY
SUITE 100
JACKSONVILLE,FL 3225
Statement of Account
Customer Number: 0000011 Statement Date: Apnl 11, 2013
ABC Customer For Customer Inquiries contact :
Ann: Mr. Smith
555 Main St. Phone: 204-680-7100
Jacksonville, FL 32224 Toll Free: 866-396-2599
Summary or Irems by Age :
1222 than i davs ald . A T
Current Page Mo.: 1 Total Page No.: 1 Zoom Factor: Page Width
For more information about using the Report Viewer window, see Report Viewer.
1. To print the statements without previewing them first, click Print. The account

Related Topics
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Statements

Statements

Report Viewer

Feedback

S GENESYS

Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

1. Generate a report.
2. Generate or reprint an invoice.
3. Preview a statement.

The following example is for a report.

| Invoice Summary - Report Viewe
" I T T T [ nm -
Summary of Invoices
All customers for system month 042013 |
ReponDae: 4112013 1
Invoice(s) Paid Us Pasd Cust  Collechons Fess DueUs Due Cust Curmrency
0000001 CUSTOMER ONE 10004 4,460.88 0.00 446088  1,1152 0.00 334566 USD
0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 1225 0.00 3675 USD
4,500.88 0.00 450988 112747 0.00 338241
h| n "W
Current Page No.: 1 Total Page No.: 1 |Zoom Factor: Page Width
Icon Description
e Exports the report to a file.
o | Prints the report.
4 Displays the first page of the report.
4 Displays the previous page of the report.
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3 Displays the next page of the report.
4 Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
i Opens the Find Text dialog box to allow you to search for text within the report.
8 - Increases or decreases the text size when viewing the report on your monitor. Changing the
text size here does not affect the size of the text on the printed report.

Related Topics

Reports

Invoices
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Transactions

Feedback

S GENESYS

Transactions

Use the Summary of Open Items tab in the Invoices window to view outstanding invoices (receivables)
for the specified customer or group of customers. You can view payment and adjustment transactions
and post them to the invoices.

Related Topics

View Payment and Adjustment Transactions

Post a Transaction to an Invoice

Generate a Customer Open Item Summary Report

Feedback

S GENESYS

View Payment and Adjustment Transactions

Use the Summary of Open Items tab in the Invoices window to view payment and adjustment
transactions by invoice for a customer.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To view payment and adjustment transactions

1. In the Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Open Items tab.
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To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

In the data grid, right-click the invoice and then click View Transactions. The Open Iltem
Transactions dialog box appears.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and

last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.
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2.
3.

= Open Item Transactions

Customer: 0000001
JACKESOMNVILLE RAME
B000 Bayreadows 'Way
Jacksomville, Fl 32256

Contact  JAMES BRCWHN
Fhone: 9045361 000

Transactions

Imwaioe: 1nac
Created Decenbes 13, 2007

Opening Balance: 209.73 (USD)
CureriBalance  209.73 [USD)

=0lx|

Transactisns USD]
Date | Transaction Descriotion Code Debis [+ Ciredits ]
kI 124132001 | Daering Balance Open 208,71

Prirk

Mam Tramsaction | Exit |

To print the information, click Print. In the Print dialog box, modify the settings as necessary and
then click Print. The information is output to the specified printer.

To post another transaction to the invoice, click New Transaction.

To close the dialog box, click Exit.

Related Topics

Transactions

3 GENESYS

Post a Transaction to an Invoice

Feedback

Use the New Open Item Transaction dialog box to post payment and adjustment transactions to an
invoice.

Note: The data grid displays invoices for parent customers only. If you select a child customer, the
Invoices program includes the parent customer number to reference.

To post a transaction to an invoice

1.

2.

In the Invoices window, in the Navigation pane, click the customer or invoicing group for which

to display invoices.

Click the Summary of Open Items tab.
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» S0l w2y 287 | 2873

10182 11001 30 | X
o el 052541 ndol | 111301
=

{ _________was  mosem 20000 | 21010
=
1 wms _______ 0oem 200000 oiaem| 000

1. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

2. In the data grid, right-click the invoice and then click Post Transaction. The New Open Item
Transaction dialog box appears, with the invoice number at the top of the dialog box.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.
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New Dpen tem Transadion

1A
0000007 - JACKSONVILLE BANE

Cument Balance: 2E T
Cunency uso

Select Trarzaction Type
(+ Paymeni Recsived
™ Paymeni Reverzal

[~ Cecreasing ddjustmenk
™ Increzzing Sdjuztment

Seect Trarsaction Dete

12019/2011 -

Corrnent [Opiional

Tiznzaction &mount in IS0
| 100.00

[Payrent Received

(o

| =

Transactions

1. In the Select Transaction Type section, click the transaction type to post.

2. In the Enter Transaction Amount box, type the transaction amount to post.

3. In the Comment box, type a comment to include on the statement (optional) and then click
Accept.

Related Topics

Transactions
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Check Register

Feedback

S GENESYS

Check Register

Use the Check Register window to generate checks or Automated Clearing House (ACH) transactions for
your customers and keep a record of all bank transactions for your agency’s trust accounts. Invoice
amounts show in the check register for those customers configured to allow checks or ACH transactions
for remittance.

Related Topics

Add a Transaction to the Check Register

View Transactions in the Check Register

Delete a Transaction From the Check Register

Create or Modify a Check Template

Specify a Check Template

Print Checks

Reprint a Check
Print the ACH Transfer List

Feedback

S GENESYS

Add a Transaction to the Check Register

Use the New Bank Entry dialog box to add a transaction to the check register.
To add a transaction to the check register

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Check Register

Bomimar I
Actions
Select Bank Account
[00000 - Gereral Trust (USD) =l ‘ | New Entp | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total [USD] | $0.00} $36.75|
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |

Click New Entry. The New Bank Entry dialog box appears.

NewBankEntryinUSD =
— 00000 - General Trust
— Select Entry Type
= Check " Deposit
£~ ACH Transfer Dut " ALCH Transfer In
i Semvice Charge " Beturned lem
~ Decreasing Adjustment (™ Incressing Adustment
Tranzaction Dezcnobion [Optional] Amount (IS0
0.an
Memo [Dptional]
Private Mobe [0 ptional)

Eritesr E sk

In the Select Entry Type section, click the transaction type.
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2 In the Transaction Description box, type a description of the transaction.
3 In the Amount (USD) box, type the transaction amount.

4. In the Memo box, type more information regarding the transaction.

5

In the Private Note box, type information that you want available internally only. This
information doesn't appear on checks or reports to the customer.

6. Click Enter. A notification dialog box appears.
7. Click OK.

8. In the New Bank Entry dialog box, click Exit.
Related Topics

Feedback

S GENESYS

View Transactions in the Check Register

Use the Check Register window to view transactions in the check register.
To view transactions in the check register

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Check Registe

N

r

Actions
Select Bank Account
| 00000 - Gereral Trust (USD) = ‘ | [Ypr— | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 UsD
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total [USD] | $0.00} $36.75|
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |

In the Select Bank Account list box, click the bank account for which to view transactions. If you
don't have a check template associated to the bank account, the Invoices dialog box appears.

This Bank Account does not have a Check Stock assooated. Click OK to select or
design a new Check Stock.

Do the following:

1. Click OK. The Check Stock Editor window appears.
2. In the list box under the check sample, click the template name.
3. Click Accept Settings and then click Exit.

In the Show Transaction Type section, click the type of transactions to view.
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3. In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

Related Topics

Feedback

S GENESYS

Delete a Transaction From the Check Register

Use the Check Register window to delete a transaction from the check register.

To delete a transaction from the check register

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
EEEC
Actions
Select Bank Account
00000 - General Trust USD) -] ‘ | New Entp | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 UsD
Sedected Enfies
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Typs Printed Memo
p | A/11/203 CUSTOMER FOUR [T $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total (USD] | $0.00) $36.75]
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |
1. In the Select Bank Account list box, click the bank account for which to view transactions.
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Check Register

2. In the Show Transaction Type section, click the type of transactions to view.

w

In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

In the data grid, click the transaction to delete.

4
5. Right-click the transaction and then click Delete. A confirmation dialog box appears.
6 Click Yes. A notification dialog box appears.

7

Click OK.

Related Topics

Feedback

S GENESYS

Create or Modify a Check Template

Use the Check Stock Editor window to create or modify a check template to use when you print checks.
The Invoices program includes a standard check template. You can modify this template or create your
own. You can use any standard 8 % x 11 paper stock that prints 3 checks per page.

To create or modify a check template

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Bomimar I
Actions
Select Bank Account
[00000 - Gereral Trust (USD) =l ‘ | New Entp | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Totd (USD) | $0.00) $36. 75|
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |
1. Click Edit Stocks. The Check Stock Editor window appears.

55



Check Register

(nsion S )
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own. US 32212 Date:  k<Date Field:>|

H| §l<Dobar Amkrel
53] Digllaiz

— 2

[Endorzement i ieu of Signature)
Memo [z Memn Fiekd»|

014250 063014495t 12345678900

To create a check template, click New. The Invoices program clears the layout settings to allow
you to specify settings for the new template.

To modify a label on the check (for example, Number or Date), do the following:

1. Double-click the label. The Label Edit dialog box appears.

Fort Size  Font
[8.25 »| |MS Sans Sent - B u| ;|

Text
M e

Thiss hed ill Be ptivited i the fonl style selected iF the lem iz enabled,

Font Size: Label font size.

Font: Label font style.
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B: Click to bold the label.
U: Click to underline the label.
I: Click to italicize the label.
Text: Label text.
1. Modify the information as necessary and then click OK.

1. To exclude a label from printing on checks, right-click the label and then click Disable this field.
The label is gray.

2. To include a label so that it prints on checks, right-click the label and then click Enable this field.
The label is no longer gray.

3. To change the location of a label, click the label and drag it to the location you want and then
release your mouse button.

4, To change the check size, click the square in the lower right-side corner of the check and drag it
to the width and height you want. Use the rulers as a guide. The Invoices program moves the
magnetic code strip so that it appears in the lower section of the check.

5. To change the number of checks to print per page, click in the Layout box.
6. If you're creating a template, in the template name list box, type a name for the template.
7. To print a grid on the background of the check, in the Grid section, do the following:

1. In the Size list box, click the size of the grid.

2. To set the grid color, in the Red, Green, and Blue boxes, type or click the color mix.
8. To print a check sample so that you can verify the layout settings, click Test Print.
9. When the layout settings are correct, click Accept Settings and then click Exit.
Related Topics

Check Register

Feedback

S GENESYS

Specify a Check Template

Use the Check Stock Editor window to specify the check template to use when printing checks.
To specify a check template

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.

57


file:///c:/builds/latitude_latitude.2022r2_systest/products/Documentation/Source/Invoices_Help/javascript:%7bmail_str%20=%20%22mailto:LatitudeDoc@genesys.com

N

Check Register

Actions
Select Bank Account
| 00000 - Gereral Trust (USD) = ‘ | [Ypr— | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Totd (USD) | $0.00) $36. 75|
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |
1. Click Edit Stocks. The Check Stock Editor window appears.
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1. In the list box under the check sample, click the template name.
2. Click Accept Settings and then click Exit.

Related Topics

Check Register

Feedback

S GENESYS

Print Checks

Use the Check Register window to print all checks in the check register that your organization hasn't
printed yet. Ensure that you have the magnetic cartridge used for checks installed in your printer and
the correct paper stock in the paper tray.

To print checks

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Check Register

r '
ELSSS e
Actions
Select Bank Account T
[00000 - Gereral Trust (USD) ] | New Entp |
Wiew Filless - Curient Accourt Balance
Show Tranzaction Typs l—Trarqu::b:n Date Range —
[ Transactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | ¥1172013 CUSTOMER FOUR I $0.00 §36.75]
ACH Dut Invoice[z) 10009
Total [USD] | $0.00] $36.75]
Prirt All Repint Select Show ACHtads Edit Stocks | Esdl |

In the Select Bank Account list box, click the bank account for which to view transactions.
In the Show Transaction Type section, click the type of transactions to view.

In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

Click Print All. The Print dialog box appears.

Modify the settings as necessary and then click Print. The Check Print Options dialog box
appears.
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reckpim oprors NI

00000 - General Trust
1 checks to print

* The Check Stock doss not have pre-printed numbess. Auto-generate Check
Mumbers starting with the last number prnded

™ Check stock is pre-numbesed and the next numbes is: |

Cancel Prnt | QK |

1. Do one of the following:

1. If the check paper doesn't have pre-printed numbers, click The Check Stock does not
have pre-printed numbers. The system prints the check numbers on the checks, starting
with the next sequential number after the last check number used. The system also
records the check numbers in the check register.

2. For pre-numbered check paper, click Check stock is pre-numbered and the next
number is: and then, in the box, type the starting check number. The Invoices program
doesn't print the check numbers on the pre-numbered check paper. The Invoices
program does use the check number you type in the box to record the check numbers in
the check register.

1. Click OK. The Invoices program prints the checks. The Invoices program records the date printed
and the check numbers in the Selected Entries data grid. The Invoices program assigns check
number "1000" to checks without a check number.

Related Topics

Feedback

3 GENESYS

Reprint a Check

Use the Check Register window to reprint one or more checks. Ensure that you have the magnetic
cartridge used for checks installed in your printer and the correct paper stock in the paper tray.

To reprint a check

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Check Register

r '
ELSSS e
Actions
Select Bank Account T
[00000 - Gereral Trust (USD) ] | New Entp |
Wiew Filless - Curient Accourt Balance
Show Tranzaction Typs l—Trarqu::b:n Date Range —
[ Transactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | ¥1172013 CUSTOMER FOUR I $0.00 §36.75]
ACH Dut Invoice[z) 10009
Total [USD] | $0.00] $36.75]
Prirt All Repint Select Show ACHtads Edit Stocks | Esdl |

In the Select Bank Account list box, click the bank account for which to view transactions.
In the Show Transaction Type section, click Checks.

In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

In the data grid, click the check to reprint.

Tip: To select multiple sequential checks, press and hold the Shift key and click the first and last
sequential check. To select multiple non-sequential checks, press and hold the Ctrl key and click
each individual check.

Click Reprint Selected. The Check Re-Print Options dialog box appears.
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e Repir O I

00000 - General Trust

1 checks to reprint

* Pont he same Check Numbers cnginally used.

(™ Check stock is pre-numbesed and the next numbes is: |

1. Do one of the following:

1. To use the same check numbers that you used originally, click Print the same Check
Numbers originally used.

2. For pre-numbered check paper, click Check stock is pre-numbered and the next
number is: and then, in the box, type the starting check number. The Invoices program
doesn't print the check numbers on the pre-numbered check paper. The Invoices
program does use the check number you type in the box to record the check numbers in
the check register.

1. Click OK. The Print dialog box appears.

2. Modify the settings as necessary and then click Print. The Invoices program prints the checks.
The Invoices program records date printed and the check numbers in the Selected Entries data
grid.

Related Topics

Feedback

S GENESYS

Print the ACH Transfer List

Use the ACH Transfers window to print the Automated Clearing House (ACH) transfer list for customers
that your organization configured for ACH transfers. The list includes the dollar amounts to pay based on
the invoices generated in Invoices. Use the list as a reference when transferring payments.

To print the ACH transfer list

1. In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Check Register

Actions
Select Bank Account
| 00000 - Gereral Trust (USD) = ‘ | [Ypr— | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n5203 | -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtamt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total [USD] | $0.00} $36.75|
Print Al Repint Selscted | | Show ACHiedo Edi Stocks ] Esit |
1. Click Show ACH to do. The ACH Transfers window appears.
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[ ACH Transfers =
ALCH Transters [USD) to be done from General Trust [Routgh 000000000] [4ccounti D000000000000000]
Entry Date . Payes Mame To Ftnu&lﬂ Mumber | ToAccount Mumber Amounk . Curency
b | 04/1173  CUSTOMER FOUR 3575/ USD
Exit | Fiint
1. Click Print. The Print dialog box appears.
2. Modify the settings as necessary and then click Print. The list is output to the specified printer.

Related Topics
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Feedback

S GENESYS

Reports

Use the Reports menu in the Invoices window to preview and print invoice-related reports.
Related Topics

Generate a Summary of Invoices Report for a Specific Time Period

Generate a Summary of Invoices Report for a Customer or Group of Customers

Generate a Summary of Receivables Report

Generate a Bank Account Ledger Report

Generate an Uncleared Checks Report

Report Viewer

Feedback

S GENESYS

Generate a Summary of Invoices Report for a Specific Time Period

Use the Invoice Summary Report to view invoices by customer for a specified time period.
To generate a Summary of Invoices report for a specific time period

1. In the Invoices window, from the Reports menu, click Invoice Summary Report and then click
Preview. The Invoice Summary Report dialog box appears.
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1.

67
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@ Invoice Summary Report )
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" For specific date 4/10/2M3 ~|
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Cuztomer Selechon

* Show all customens
" Show only customers that have nvoices

Sort Option
= Order by customer rumber

" Order by customer name

Ext | Bean |

L5 oy

In the Select Invoices Created section, do one of the following:

1. To generate the report for a specific month, click For system month and then, in the list
boxes, click the month and year.

2. To generate the report for a specific date, click For specific date and then, in the list box,
click the date.

3. To generate the report for a specific time period, click From and then, in the list boxes,
click the beginning and ending dates.

In the Customer Selection section, do one of the following:
1. To include all customers in the report, click Show all customers.

2. To include in the report only those customers with invoices, click Show only customers
that have invoices.

In the Sort Option section, do one of the following:
1. To sort the report by customer number, click Order by customer number.
2. To sort the report by customer name, click Order by customer name.

Click Begin. The Report Viewer window appears.



Reports

|4] Invoice Summary -: Report Viewer
@ S 1 A -
Summary of Invoices
All customers for system month 04,2013 |
RepontDate: 4/11/2013 1
Inveice(s) Paid Us Paid Cust  Collections Fess DueUs Due Cust Currency
0000001 CUSTOMER ONE 10004 446088 0.00 4.460.88 1,115.22 0.00 3,345.66 UsD =
0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 12.25 0.00 36.75 UsD
4,500.88 0.00 450088 112747 0.00  3,382.41
4 n 2
Current Page No.: 1 Total Page No.: 1 |Zoom Factor: Page Width
1. To export the report to a file, do the following:
1. In the menu bar, click the Export icon. The Export Report dialog box appears.
2. In the File name box, type a name for the report.
3. In the Save as type, click the type of file to export the report to and then click Save.

When the export completes, a notification dialog box appears.

4. Click OK.

2. To print the report, do the following:
1. In the menu bar, click the Print icon. The Print dialog box appears.
2. Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Invoice Summary
Report, specifying the report parameters, and then clicking Printer.

Related Topics

Reports
Report Viewer

S GENESYS

Generate a Summary of Invoices Report for a Customer or Group of Customers

Feedback

Use Summary of Invoices tab in the Invoices window to generate a Summary of Invoices report for a

customer or group of customers.
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Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To generate a Summary of Invoices report for a customer or group of customers

1. In the Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Invoices tab.

Fummary of brvosces |Sqmdﬂpmh|-|

ODOOCODEFALILT
D000 -FRST CL Al Cuanbomers
DO0000Z-SECOND r
DOD0003-THIRD €L +
DOOOD04-4EC CLIS | Varer rate Rlange
[rmeame =] w [anome =]
o T e [y e G
Irrwoice {Gecan Collections Fess Summary -
irvoice | Date [Smdo] Psdls | PesdCust | TowlPmis | Eamed Duslls | DueCun
¥ | Y0090 M| A9 30000 000 0 0 15000 i 150000
WO | NS 49 | 100,00, 000 WO0E 5000 50.00] 10000
- > o
: Cumtomes Group Sedected “l Customen” 259PH AN/ANa
1. To change the date range for which to display invoices, click the arrow next to the date range

boxes and click a beginning and ending date.
2. In the data grid, click one or more invoices.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.

1. From the Actions menu, click Print. The Print dialog box appears.
2. Modify the settings as necessary and then click Print. The report is output to the specified
printer.

Related Topics
Reports
Report Viewer

e e
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S GENESYS

Generate a Summary of Receivables Report

Use the Summary of Receivables report to view a summary of collection fee amounts owed to your
agency.

To generate a Summary of Receivables report

1. In the Invoices window, from the Reports menu, click Receivables Report and then click
Preview. The Report Viewer window appears.

PR
ij '] 1l ¥ ¥ 1 ﬂlﬂﬂ'

Summary of Receivables

Feport Date :4/1 172013
Page1of1

Cradin Balmes Currency

Total Page No.: 1 |Zoam Factar: Page Width
1. To export the report to a file, do the following:
1. In the menu bar, click the Export icon. The Export Report dialog box appears.
2. In the File name box, type a name for the report.
3. In the Save as type, click the type of file to export the report to and then click Save.

When the export completes, a notification dialog box appears.

4. Click OK.

2. To print the report, do the following:
1. In the menu bar, click the Print icon. The Print dialog box appears.
2. Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Receivables Report and
then clicking Printer.
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Related Topics

Reports

Report Viewer

Feedback

S GENESYS

Generate a Bank Account Ledger Report

Use the Bank Account Ledger report to view the ledger for each trust account that your organization
configured in Latitude.

To generate a Bank Account Ledger report

1. In the Invoices window, from the Reports menu, click Bank Transaction Report and then click
Preview. The Report Viewer window appears.

BANK ACCOUNT LEDGER Today's Date: Apr 10, 2013

BEACH BANK ¥ Cusgent Balance - (29.11)
2356 BEACHBLVD
JACKSONVILLE, FL 32156

Them Description

BARNES, MICHAFL C
Refund of overpavment from account 1012
UID=35

Our Balance (29.11)
Less Unreconcilad Diehits . 0.00
Plus Unseconeiled Cradis

Emk's Balmee

4

Current Page Mo 1 [Total Page No.: 1 |Zoom Factor: Page Width

1. To export the report to a file, do the following:
1. In the menu bar, click the Export icon. The Export Report dialog box appears.
2. In the File name box, type a name for the report.

3. In the Save as type, click the type of file to export the report to and then click Save.
When the export completes, a notification dialog box appears.

4. Click OK.
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2. To print the report, do the following:
1. In the menu bar, click the Print icon. The Print dialog box appears.
2. Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Bank Transaction Report
and then clicking Printer.

Related Topics

Reports

Report Viewer

Feedback

S GENESYS

Generate an Uncleared Checks Report

Use the Uncleared Checks Report to view a list of checks received from the customer that have not
cleared the bank.

To generate an Uncleared Checks Report

1. In the Invoices window, from the Reports menu, click Uncleared Checks Report and then click
Preview. The Report Viewer window appears.

Uneleared Checks Report 0471172003 11:05 am
Page 1 of 1

Entered Date  Check Mo Custome Prmted Date

Tatal

All Banks Total

Zoom Factor: Page Width

1. To export the report to a file, do the following:
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1. In the menu bar, click the Export icon. The Export Report dialog box appears.
2. In the File name box, type a name for the report.
3. In the Save as type, click the type of file to export the report to and then click Save.

When the export completes, a notification dialog box appears.

4. Click OK.

2. To print the report, do the following:
1. In the menu bar, click the Print icon. The Print dialog box appears.
2. Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Uncleared Checks
Report and then clicking Printer.

Related Topics
Reports
Report Viewer

Feedback

S GENESYS

Generate a Customer Open Item Summary Report

Use Summary of Open Items tab in the Invoices window to generate a Customer Open Item Summary
report for a customer or group of customers.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To generate a Customer Open Item Summary report

1. In the Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Open Items tab.

3. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

4, In the data grid, click one or more invoices.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.

1. From the Actions menu, click Print. The Print dialog box appears.
2. Modify the settings as necessary and then click Print. The report is output to the specified
printer.
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Related Topics

Reports

Feedback

S GENESYS

Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

1. Generate a report.
2. Generate or reprint an invoice.
3. Preview a statement.

The following example is for a report.

Summary of Invoices
All customers for system month 042013

ReportDate: 4/11/2013

Invoice(s) Paid Us Pasd Cust  Collechons Fess DueUs Due Cust Curmrency
CUSTOMERONE 10004 446088 0.00 4.460.88 1,115.22 0.00 3,34566 UsD
CUSTOMERFOUR 10006 49 00 0.00 49.00 12.25 0.00 36.75 UsD

4,500.88 0.00 45008 112747 0.0 338141

Current Page No.: 1 Total Page No.: 1 |Zoom Factor: Page Width
Icon Description
e Exports the report to a file.

o | Prints the report.

4 Displays the first page of the report.

4 Displays the previous page of the report.
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Invoices Printable Help

3 Displays the next page of the report.
4 Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
i Opens the Find Text dialog box to allow you to search for text within the report.
8 - Increases or decreases the text size when viewing the report on your monitor. Changing the
text size here does not affect the size of the text on the printed report.

Related Topics

Reports

Invoices
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